Flipping Shopping Catalog
Builder digital shopping catalog with page
flipping effect

mobiano9
www.flash-flipping-book.com
1/1/2012



http://www.FlashFlipBook3D.com/pageflip-3d/index.html

e _ ‘v"" Convert PDF to Digital Shopping Catalog Program
: User for document

About Flipping Shopping Catalog

Flipping shopping catalog is designed especially for
businessman or other relevant people to promote their
products more effectively and enlarge their business. With
its help anyone can make a media-rich digital shopping
catalog from your original PDF files including video,
YOUTUBE video, SWF flash, or image and many other medias
imaginable. Besides, you can not only edit your slogan as you
like and place it everywhere on your page , but also update

the price at any time.

Note: This product is distributed on a "Try before-you-buy"
basis. All features described in this documentation are enabled.
The registered version doesn't insert a watermark in your

generated page-flipping eBooks.

Basic features

1. Convert any PDF file Cincluding its bookmark, links) to adobe flash based
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flip book;

2. Support batching convert bulk pdf files to flipping book;

3. Import all the pages from original or just some pages based you needs;

4. Define the quality and size of the book whatever you like;

5. Set a exclusive watermark which is only belong to yourself;

6. Keep the hyperlink including web link, page link and email link of the
original PDF files in flipping book;

7. Import or edit bookmark to divide the book into categories for easy
reading;

8. Import whole book text content to enable full-text search , useful for
bigger page flips;

9. Detect wide page so that It can be viewed clearly and comfortably;

10.Select a built-in theme or template (classical, float, neat, spread) as you
like;

11.Add your own book title or book logo to the flipping book button bar;

12.Show or hide home button, help button, print, download to make your
book more flexible and powerful;

13. Define content of help window, also the looks and feels;

14. Decorate shopping catalog with your favorite color
14.1 Define button color, search highlight color, icon color;
14.2 Set font color, whether window font, book mark font, window font

or search result font;
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15.

16.

17.

18.

19.

20.

21.

22.

23.

24.

25.

26.

27.

28.

14.3 Design background color, flash window color and page background
color;

Insert a sound file which will be playing as a background book music;

Use zoom in/zoom out unlimitedly and set zoom scale;

Share with your friends via email or upload it to social network like
Facebook, Twitter, Digg, Google, etc;

Support auto-flip with flip-interval and play count setting;

Enable single page or double page view mode;

Define Multilingual version books for different language users;

Add book frame bar to flip much easily;

Set book reading from right to left for words start with left languages;

Design hard cover to enhance the reality of the book;

Set a password to prevent disallowed accessing;

Use GOOGLE analytics to know the number of people who have read your
published book;

Preview the effect after setting right away;

Export and save the project if you think everything is okay;

Output the book in different formats (HTML, ZIP, EXE, Mobile version,
burn to CD)
28.1 HTMLis a format which can make you upload your book online;
28.2 ZIP is a format which allow you share the book with your friends via

email;
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28.3 EXE is single output format which allow book reading separately;
29.use about button to add your contact or some other information;
30. Change the existing icon on toolbar through editing icon flash file;

31.Insert new button icon calling new action if necessary.

Media-rich features

1. Add image to the page you imported (customize its action, like play audio,
go to webpage ,etc);

2. Add links( define action) to your page;

3. Insert FLV movie and define every detail of the movie;

4. Add any sound to your page;

5. Insert SWF flash to enrich your page;

6. YOUTUBE video can be added to your page;

7. Output project embed links, video and sounds, save it for future using;

8. Support command line conversion.

Smart sales features

1. Insert text button to edit your slogan and many other related words;
2. Add price button which mark your product and define its action type;
3. Add button with professional sales icon ( many buttons available ) you

need and define its action type;
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4.

Insert pop—up picture to enrich your shopping catalog and define its action

type.

Prospective buyer features

9.

10.

11.

12.

13.

14.

After you finish your book, your prospective buyer will be enabled to:
Drag the corner of the page to go to previous or next page;
Click the page arrow or page frame to reach the previous or next page;
Use thumbnail button to navigate fast through a large publication;
Just need a few clicks on navigation buttons to go to previous page, next
page, first page and last page;
Click help button to get a hand when needed,;
Use search button to find out the page to get related info;
Print out the whole book or some pages only;
Make the book full screen for convenient reading;
Zoom in/ zoom out on pages if the page font is too small to read;
Turn on/ off the background music;
Flip with a single page or double pages;
Share with anyone via email, Face book, Twitter, Digg, Google etc;
Download the ZIP or EXE book from website to read locally directly;

Enjoy this digital publication on iPad, iPhone and Android devices.
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Quick Start

v
1. Launch the application via the desktop shortcut;

3. Click L#2**= licon to choose PDF file from your computer;

2. Click the "Import" icon to enter into Import PDF interface;

4. Click ImPerthow [;q, to enter into template setting interface;

5. Edit shopping page objects, define parameters for eBooks, such as

Book, Tool Bar, Bookmarks, and then click the "Apply Change" icon ;

3 T

6. Click "Convert to Flipping Book" icon " to enter into Output

interface;

7. Choose Output Type from HTML, ZIP and EXE, here take

¥ @ -om

as example;
8. Click | ®?"*= |{5 set Output Folder as "C:\flipbook", input File Name
as "demo";

| Lonvert |

9. At last, click icon to output created page-flipping eBook.

You can open the "flipbook" folder in "C:", there are three files in this folder:

e &

files book. swf demuo.html
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Open the "demo.html" file to view your created pOOage-flipping book via Web
Browser, such as Internet Explorer, Google Chrome, Firefox, etc.

B dems - Winder Isternet Eaplorer el 5]
(il e campbooksdemo "_'rih"r_:;l’--_- —
FrEmET—

| i domo | B~ B -3 v B Seeyr Tookv @

ipping Shopping Catalog

Boildar cHghal ibopabng catalog sith gige Rlaging =ifed.

By M= -

S VI

o7 A mEeqao oW

&) Internet | Protected Mode 08 i = Hlww -

Interfaces

There are some main interfaces you will see while using Flip Shopping
Catalog as below shows: Application Options, Import PDF, Template
Settings, Edit Pages, Language Option, Export Theme, Output, Batch
Convert and Command Line.

You can enter into each page to get clear instructions for every detail

option.
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I. Application Options Interface
1. Render Engine Option

Flip Shopping Catalog provides 3 different render engines for you to create higher
quality page-flipping eBooks (change option when PDF imported failed), click
"Options->Application Options" to enter into "Render Engine" interface:

SWF: Much legible characters, smaller output size

GPL Ghostscript: Higher color transfer quality

Inner Library: Faster convert speed

Feamder Engane

Fiease seleche a render engine for the conversion

kel
EL"."F
L
ar-u
L Ghestsript Dowdoad Ghosteript
F
[ LEH ]

@ frner Library

SWF: Much legible characters, smaler output size

L Ghostsoript: Higher color ransfer quality

Inner Library: Faster convert speed

2. Create Mobile Version Option

(1) Pages Quality and Size
Five types of "Pages Quality And Size" for mobile version eBooks:

Pages Quality and Size

Quality And Size:

gher gual =
High quality large file size
Medium guality medium file size
Low quality small file size
Lower quality smaller file size

( Highvaluesp
© butrequire

(2) Mobile Template

The current version provides two mobile template modes for you to use: Slide and
Single Page Flip. The later one adds page-flipping effect on the pages while viewing
in mobiles.
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Il. Import PDF Interface

Source PDF Flie

Browse.. | | Open it
The Page Ranges to Import Watermark
@ Ml poges ME Place a custom text or image
) Custom range: | 1-10 e o] |§. - Watermark(Stamp) to the file(s)
Quickly import (Only import 10 pages to initial preview) Set Watermark |
Page Quality
Quality And Size: | Medium gquality medium file size - |

M High values produce better page quality but require more disk space and more time to download.

[ 1mpart bookmark [¥] 1mport links [¥] Enable search [ petect wide pages

[ Import Now ] | Cancel

1. Source PDF File:

Click this icon to open the PDF file you want to convert;

Open it View content of added PDF file to clarify before converting.

2. The Page Ranges to Import:

©alpagEs oo hvert all pages to page-flipping eBook;

@ Custol AN E le:1,3,5,9-21 .
EEe xampie:1, Convert defined range page;

[¥] Quickly import (Only import 10 pages to initial preview) Just preview effect on first 10 pages

3. Watermark

Add image or text watermark to flipping pages.

=l ing W a . N
(¥ Appiying Watermark Check this option first to choose default stamps or add new ones:
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Page-flipping eBaok

& Edit /
&  Add text stamp
= Add image stampa s imse wems = D —
Add Tmage Watermark
® Delete Inage ame
e Image Watermark
+  Move down - e
%+ Move up gy i
Wt 0 * Heght: % %
atmmeﬂ aenmw@
Image Effact
Opacty: 0% 1 100%
Rotaton: 0 +| dogree 2] & badkground
Podton in margns Marpra
T e
= = u = =
wed & pewm B
el Eottom: 20 3
e
[ menetecs
o [ wen |

4. Page Quality
There are five types of "Quality And Size":

'_'._: A i (BEH A E Si

large file size
Medium guality medium file size
Low guality small file size
Lower guality smaller file size

5. Other Options:

[} tmport bookmark If your PDF file contains bookmarks, check this option to use in output

page-flipping eBook;

[V 1mpert links If your PDF file has links, check this to enable in flipbook;

Enable search o ok this option to enable search functionality in created flipbook.

[ViDetect wide pages  cpack this option to make landscape page in PDF file to be presented as

two-page spread in output flipbook.

At last, click m icon to enter into template setting interface.
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lll. Template Settings Interface

B ey Gl

[ ———

i e irenoey Duwe S ::'_'..Fl-ql:li (B oty D U Comrert TnFippeg Bl |- s, Do

lipping Shopping Catalog

digal nhogphng catibog wits page Mippiag sffect.

mo i

i

The design setting interface contains below main parts: Choose Template, Tool Bars
Settings, Flash Display Settings and Flash Control Settings.

1. Choose Template
Templates

‘ If classical ‘H @

Please customise the ﬂash template here .

4 Choose a fipbook template here. (Double-chid: to make a quick selection)
B (More and more tes will be provided in future,)
-

Templates
B8] Classical
) Foat

[iE spread

Download more themes from FlipBuilder now:

http://www.flash-flipping-book.com/templates-themes/theme.html .
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2. Tool Bar Settings

IEITDDI Bar Settlngs
[HTitle Bar

- Click this icon is to import stored setting file at once.

.Buttc.ng Bar e G

AddIconsSettngs |

HButton Icons

I
... T‘:":'l Bar e tc'F' o |FEes
i
L

(1) Title Bar (only in Float template)

| E|'I'ﬂe Bar _____

| _ The Enuk Lr:ugu:u e 'IJJSEFS",AdI‘I‘III‘II
| _ Ll:ugo LIRL ________ [http: .U"ﬁlpl:ulder
i Eicu::nk.'l'ﬂe <a href="http: /. ..
[ _ F'age MNumber Box On .. False """ -_'J

Jy FLIPBUILDER.COM |

Customize book title and logo for showing on the top of your flipbook. You are enabled to

set the book title as HTML format text. For example: <a

Click this icon is to save current settings as a TXT file for later uses;

href="http://www.flash-flipping-book.com' target='_blank'>FLASH-FLIPPING-BOOK.COM</a>

| <font color="#ff0000' size='14'>Red Color</font>

(2) Buttons Bar

~ [FHome Button
: IAI:n:lut Button

Thumbnall Button  |Enable
Smgle F'agE P@able

i. Home Button

You can add a home buttonn to help reader to click and go to your website directly:
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Home Button Visible S_how_ )
Page URL http:/fflipbuil. .
Open Window |Blank

ii. About Button

Add About button N\ to show the author, contact, book, company info:

. BboutButton [
! About Button Visible  [Show
l Content ':textﬁ:rmat:J

Click "..." to enter into "About & Contact" edit interface:

| About & Contact Settings

i
Flip PDF Professional DemoBook * | K Clear |
Presents powerful features in the Flash digital eBook, such as sodal share, print, autoplay
ete, | Bl save ss.. |
Contact us at: alice@flipbuilder.com
http://fipbuilder. com | JJJ Load.. |

| 5 Demo

You can use some “tags” to format the text shown in the "About & Contact” window, such as text font, font color,
hyperlinks and so on.
Mare details about tags please: Click Here

‘ [ox]|gancel|

After clicking the About button, you will view the About window by clicking the button:

. \0 About & Contact

Flip PDF Professional DemoBook

Prezents powerful features in the Flash digital eBoolk, such as social share_ print,
autoplay ete.

Contact us at: alice@flipbuilder-com

httpo/flipbuilder.com

iii. Full Screen Button

To enable "Full Screen" functionality in output flipbook, select "Show" in "Full Screen
Button" option: Full Screen Button Shaw

o = . . . S
Then you can click icon to view flipbook in Full Screen, click icon E or "Esc"

button to exit from the Full Screen.

Or if you want to show your flipbook without Tool Bar while showing in Full Screen mode,

you can set "No" in "Full Screen without Tool Bar" (just in Classical Template):
Full Screen Without Toal.. | Yes

Copyright 2012 by flash-flipping-book.com
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iv. Help Config

BHepConfig B
Help Button |Shaw

Help Content File {-type.png =

. Help Window Width 1400

. Help Window Height 1450
Show Help At First |Shaw

To show tips about viewing flipbook, you can set "Show" in "Help Button" option, and you
can define Help Content manually by inserting "Help Content File (image or SWF)", also
enable to define the Width and Height of the Help image or swf. If you set "Book->Retain the
book to center->No", you can set "Show Help At First->Show" to display the Help Panel with
the Book as below:

lipping Shopping Catalog

(g bbbt gl whangpring dptaking with page Fipping sife

SO

— = ot
o Ny N -
Dol chil P Pbemm o, ey it
D Phor pubgr fdwees o = -

L e whewl ta [l papri

You can also click the button to view the same Help page in pop-up window.

v. Print Config

Print Enable |Yes
Print Wartermark File | BES s Ealgl)

Choose "Yes" in "Print Enable", then click icon to set print page range as below:

& Pmnt '

=) Print A1 Pages
_ Print Current Page
. Print Range

Example; 2 58-26

=, Print
4

You can also click "Print Watermark File->..." button to choose image or SWF file from your

Copyright 2012 by flash-flipping-book.com
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computer as watermark on printed out pages.

vi. Download Setting

E|.D_D_w|.'|l.na_d éetﬁ_nﬁ_
Download Enable es |
[ Download URL 3DFDema.pdf!

If you want your flipbook readers to download the PDF file or the flipbook directly from your
website, select "Yes" in "Download Enable" option, then input the Download URL directly,
you can use absolute path like
"http://www.flash-flipping-book.com/flip-pdf/example/files/download/FlipPDFDemo.pdf"
or relative path like "/files/download/FlipPDFDemo.pdf" (make sure you have uploaded the
PDF to the same path).

Then readers can click the icon n to download your uploaded PDF file directly.

vii. Sound
ElSound
Enable Sound |Enable E
[ SoundFie EERE
Sound Loops -1

If you want to add background sound to your flipbook, such as a song or other audio file, set
"Enable Sound->Enable", then click " =" icon to choose "Sound File" from your computer,
then set "Sound Loops", "-1" stands for playing the sound file all the time while viewing
flipbook, other value (N>0) stands for the times of playing the sound file.

viii. Zoom Config
Blzoomconfig |
...foominenable | es
Zoom Scale 1.5

To Enable Zoon In functionality, choose "Yes" in "Zoon in enable", then set "Zoom Scale", the
value is the times between zoomed page size and the current page size.
In Float template, you don't need to set Zoom Scale, you can adjust more conveniently by

the zoom in tool like this: m u You can also set "Scroll

with mouse->Yes" to scroll zoom in page while moving mouse.

Copyright 2012 by flash-flipping-book.com
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ix. Search
| SearchButon  [Show o
_ Search Highlight Color | JoxFFFFa0

Least search characters |3

Select "Show" in "Search Button" (make sure you have check "Enable Search" option in
"Import PDF" interface), then define "Search Highlight Color", after clicking "Search" icon

, you will see a popup box to input search words, then click Enter or "Search" button,

you will get the below searching result:

You can share via emails, or just through Facebook, Twitter, Google, etc..

a. Share Button
If you want readers to share via Email, you can enable "Share" feature as below shows:

Elshare Button .
Share Button Show
_Email Subject Rear my fii...
Email Body {linkX

When the viewers click the share button E, they will enter into the Email interface with

the link of your flipbook in the Email body.

b. Social Share
If you want your flipbook viewers to send the link to their friends or clients via Facebook,
Twitter, Linkedin, Google, Yahoo and so on, you can add a Social Share button in your

flipbook for readers to send out your flipbook link immediately:
[ Social Share Button |Show

The readers just need to click the "Social Share" button ﬁ, then the below window will pop

up for them to choose share channel:

Copyright 2012 by flash-flipping-book.com
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xi. Auto Flip

To auto flip your eBooks, you can set "Yes" in "Auto Flip->Enable" option; then define the
Flip Interval (seconds of staying on each page); the value of "Play Count" stands for the times
of auto playing the eBook, and "-1" stands for playing forever (after clicking the Auto Flip

button “, the flipbooks will be flipped by staying 3 seconds per page); if you want to

auto start and flip the eBook after opening, just set "Auto flip when start up->Yes":

BaseFp
I =
oo FlipInterval
MR s e S o SRR |
 Autofipwhenstartup [Yes

xii. Thumbnail Button

| Thumbnail Button |Enable |

Show Thumbnail Button E(set "Enable") to view page thumbnails of your book, or you can

Disable it to hide the button.

xiii. Single Page

[ Single Page |Enable |

If your book contains landscape pages, or the page content is different to read for the font is too

small, you can set "Single Page->Enable" to enable readers to click "Single Page" icon n to

view pages one after another, then click "Double Page" icon m to back to the normal book

reading mode.

(3) Tool Bar on Top (only in Float template)
If you want to place the toolbar in Float templates on the top of the flash eBook, you can set
"Tool Bar on Top" as "True":

[ Tool Bar on top [True

Copyright 2012 by flash-flipping-book.com
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(4) Add Icons Settings
If you want to add some other kinds of buttons which the program doesn't provide, you can click
"Add Icons Settings->..." to enter into "Icons Settings" interface to add new icons on tool bar:

Ald Tcons Setings
& lcon: Settings EE

% pemove Eoon S e 4 povetn HoveDown |

Archon Type ALDon Conlent

] |
|
Colsars\Adminustr atar Dasktoa e folder mage: | Growseee | | Open | | |
futton Info
Caghon: GoTo Page &
[con Button Achon
|
@ G0 0 page Cpn a brk Cad Javastript function

Page Irndex: g

You can define the link action as "Go to page", or open an online webpage, or even "Call
Javascript function" to carry out your wanted interactive functionalities via defining Javascript
function yourself.. After your "Apply Change", the new added icon will show in the toolbar. (More
details about Call Javascript function will be introduced in the part of "Edit Page->Add Link".)

(5) Button Icons
Define settings for the icons of the buttons:

HeButton Icons |
Lo Ieoncolor o |CIOFFRE
Icons File(SWF Only)

i. Icon Color

Tcon Colar [T JowrrFF =]

7?7 Q — =@

s

ii. Icon File
Select the Tool Bar Button to replace with your own icon.

[ IconsFile(SWFOnly)  [C:\Jsers..]

More details please view here:

http://www.flash-flipping-book.com/support/how-to-replace-icons-on-flash-toolbar.htm

Copyright 2012 by flash-flipping-book.com
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3. Flash Dlsplay Settings

E|F|ash Dlsplay Settings

language En.':!'sh .....
BFont
. Imitial Show Mome
 @Background Config o )
 Flash Window Color | [l0:x454545

Page Badcground Color | ClosefHFe

U:I
=]
=)
7\_
£
=
=]
=] 2
o
=
ck
=]
= |
[

.BUDkME.'fQ'US. .................
BPageShadow

Hide Book Frame Bar ~ |No
__ RightToleft Mo
HerdCover Mo

Fipping Tme o8 .
_BPagetumber |
HMinime Style

(1) Retain the book to center
| Retain the book to center [Yes d |

If you select “No” in this option, the eBook will be shown on the right-side. This setting is for
embedding special background image, such as advertisement or company log.

(2) Language

|_Language |English -|

You can set language for showing tools or tips in your created flipbook, and here is the
specialized instruction page for setting the "Language Option".

(3) Font

e S ]
i IR I !
| ESearch |

If you want to change fonts of toolbar buttons, flash windows even bookmarks or search
result panel, you can set font types and colors in Font Panel.

(4) Initial Show (set in Float/ Spread templates)
You can show Bookmark panel or Thumbnails panel on the flash page at the beginning, just
select "Bookmark" or "Thumbnails" in this option:

", ] Initial Show Thumbnails "|

For Example, select "Thumbnails":

Then you will get flipbook shown with below initial interface:

Copyright 2012 by flash-flipping-book.com
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Eook Contomt

B T Bt s 5

o o ey -

(5) Background Config
i. Background Color:

Blfsckground Config
ElBackground Coior
GradentCoor A | CINFFPFFF
Graden Color B W0x000000
Gradent Andle w0

Gradient Color A
oy

Gradiant Color B

M

Builder digital shopping catalog with page flipping effect.

™ ———

-

Define background for your flipbook with gradient color or pure color (the same color for

"Gradient Color A" and "Gradient Color B"). Gradient Angle is the angle between the two

colors.

ii. Background Image (set in Classical and Spread templates):

Click the icon " =" to choose background image from your computer, and there are 11 kinds

of "Image Position" for you to choose: Scale to fit, Fill, Top Left, Top Center, Top Right,
Middle Left, Middle Center, Middle Right, Bottom Left, Bottom Center and Bottom Right.

-20-
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iii. Background Image (set in Float template):

The Float template enables you to add two background images: Outer Image and Inner
Image. You can make Inner background image to show special information, such as
advertisement or company logo, etc. There are also 11 kinds of "Image Position" for you to
choose: Scale to fit, Fill, Top Left, Top Center, Top Right, Middle Left, Middle Center, Middle
Right, Bottom Left, Bottom Center and Bottom Right

(6) Flash Window Color

Flash Window Color

‘/i_.'lm#'_ﬂ

[

This color will be applied on all flash windows, such as the book window, "Help" window,
"Print" window and so on.

(7) Page Background Color

... Page Background Color

When load pages, or if the page number of your PDF file is odd, then the page (the last page)
will show with the "Page Background Color".

Copyright 2012 by flash-flipping-book.com
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(8) Book Proportions

[ElBoak Propor tions:
Page Width 052
Page Heght 1500

Heighf

Please note that the values are not fixed in pixels or inches, they just represent a ratio for
"Page Width: Page Height", and the book size will be changed depend on your Explorer
Window Size.

(9) Book Margins

i. Book Margin (set in Classical Template):

S Idl argin

"Book Margin" refers to the distance between the book and the toolbar.

ii. Top/ Bottom/ Left/ Right Margin (set in Float/ Spread Template):

(10) Page Shadow

ElPage Shadow ‘
....lefipage shadow  ls0
.. Fidhtpage shedow 125 T T
Page Shadow Opadty 0.5
Lefe page Shadow

Right page Shadow

The value also takes the value of Book Proportions as reference, and the value interval of
"Page Shadow Opacity" is "0~1", the larger value refers to the deeper shadow color.

Copyright 2012 by flash-flipping-book.com
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(11) Hide Book Frame Bar

| Hide Book Frame Bar Yes ﬂ

If don’t want to show the book frame bar, choose “Yes” in this option.

(12) Right to Left
If the language of your file is read from right to left (such as Arabic), then choose "Yes" in
"Right to Left" option:

Roght To Left Yes

Next Page|

(13) Hard Cover
If you want create hard cover effect (a book bound with rigid protective covers) for your
flipbook, choose "Yes" in "Hard Cover" option:

Hard Cover |Yes

(14) Flipping time
Flipping Time 0.5

Sets page flipping time in seconds according to needs. (Recommended second value is 0.6)

(15) Page Number

If you don't want to count in the cover page, table of contents pages into the actual page
numbers, you can set "Start Page Numbering (Roman)" and "Start Page Numbering (Arabic)".
For example, the first 3 pages are Table of Content pages with Roman page numbers, and
set Arabic page numbers from page 4, then you will get page number box like below:

| BPagetumber [
| StartPage Mumber Romar) 10 |
[ Start Page Mumber (Arabic) (3 |
\Front Cover Page: |

pages: [N
IThe Fourth and Fifth Pages: |

Pages:
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(16) Minime Style
To present Page-flipping eBook pages directly without showing toolbar, especially when you want
to embed eBook into a small area in existing webpages, then you can use this "Minime Style":

ElMinime Style |
| UseMiimeStde Yes
e s B el

Height |

Click to view in fulls

The Minime Style will trigger when the Width or Height of the Flash Container is less than the
defined value. You can also always show the page-flipping eBook in Minime Style with adding a
parameter to your URL like this: www.yourdomain.com/index.html?alwaysMinimeStyle=true .

4. Flash Control Settings

IElFlash Contral Settin_gs

| scamtysemngs o Security
| Binks s
|  Google Analytics ID

(1). Security Settings

[ Security Settings Single Pase |

If you want to protect your flash books with passwords, you can click "..." icon to enter into

"Flash Security Config" interface:

Hote:
Srge Passward opbion mebns fal useis need B passwad 10 view the flash book.

Exciude Front Paes option i5 b set a poge number, alllatier pages can't be
viewed veithout inputting password,

Serurity Tyoe
P Seurity

Lﬁ\‘ & e Passwmord: 127456

Protect Page Range
&l Papes

@ Excude Front Pages ]

Lo ) [ om

Select "Security Type->Single Password", and input passwords into the box (there is no
restriction on password format at present). You can also set "Protect Page Range" as "All
Pages" or the latter pages after a defined page number. (Tips: The program utilize RC4
algorithm to protect eBook pages, the eBook content pages will show nothing without
permission.)
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Creste your professional fipoing bock wih POF fies

If you have check "Import links" option in "Import PDF" interface, or add links in "Edit Page"
interface, then you can define settings here, choose "Mouse over color", "Link alpha" (refers
to the link area opacity, value interval: 0~1, "0" stands for the area is totally transparent),
and "Open Window->Blank/ Self". The links also can be clicked after zooming by setting
"Enable after Zooming in->Enable".

(3). Google Analytics
G;:uﬁgle Analytics ID

In the HTML output format, you can add statistics by using google analytics. You can get
more information about Google Analytics ID from http://www.google.com/analytics/ .

Besides, Export Theme

If you want to save the current template settings as your own style template for later uses,
you can click "File->Export current settings as Theme" button to storing all current template
settings, include the background images, margin values, toolbar buttons and so on.

Then when you want to use later, just click "File->Import Themes", the theme will be added
to the templates selecting interface. Download more themes from FlipBuilder now:
http://www.flash-flipping-book.com/templates-themes/theme.html .
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IV. Edit Pages

Now you can use Flip Shopping Catalog to edit imported pages directly, no matter you want to
add shopping price, item, product detail photos slideshow, link, video, sound or image file. Just

click "Edit Pages" button | to enter into the editing interface:

1. Text Button

—
Click the icon. and then draw a button on a page, then define properties in below panel:

Text Button Properties

Font Color:
O Down @ Up @ Mave

URL:

| Advance Action Options

® Over ® Out

® Gotopage © Openaink ™ Cal Javasoipt function
® Open Flash Window @ Ply Audio #® Photo Sideshow
URL:

Link Target: Blnk

Define Button Text, set link URL, there are many different action options, like Go to page, Open a
link, Call Javascript function, Open Flash window, Play Audio and Play Slideshow.
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2. Price Icon

Click "Price" icon to add price for products like this: ERt AL
You can also edit the icon type yourself in Properties panel:

Properties

Hint
Price Unit
Price

Background Color O Down ®up B

® Over e

URL:

® Go to page © Open alnk @ Call Javascript function
Advance Action Options
@ Open Flash Window @ Ploy Audio ® Photo Shideshow

URL:

Link Targat:

3. Add Product Photos

al

Click "Product Photos" icon to add images to pop-up in slideshow format:

Photos

URL Action

.(files/pageConfig/1.jpg Delete

.JfilesfpageConfig/1.png _Delete

Delete

.[files{ pageC

Add Images
A_dvance Action Options O Down @ Up @ Move

® Over ® Out

® Go topage ® Opena =k @ Call Javascript function

® Open Fash Window @ Phy Audic [ Photo Slideshow
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4. Add Button from Resources
Flip Shopping Catalog also provides many nice and typical resources for you to use on ebooks.

HE -
Click icon to add the icons onto pages, you can also use your own icons:

Button Resources Proparties

URL:

Advance Action Options

" Action Options

B Down @ Up @ Move

& Over ® out

® Gotopage © Openaink M C it function
® Open Fash Window I Py Audio # Photo Skdeshow
LIBL:

Link Target: Blank

Import Resources

5. Add Link

Click the icon and then draw a link box on the area you want to add link, then define
properties in below panel:

Link Properties

O Down @ Up ® Move

® Over ® out
Over Color: . Ovar Alpha:

Down Color: - Down Alpha:
Normal Color: MNormal Alpha: ™ Go to page ™ Openalnk ® Call Javascript function

™ Open Fash Window @ Play Audio ® Photo Slideshow

URL:

You can define the link action as "Go to page", or open an online webpage, or even "Call
Javascript function" to carry out your wanted interactive functionalities via defining Javascript
function yourself.. For example, you can show a pop-up light box while readers clicking some
image on page, or pop-up a questionnaire or other Web Form by clicking some text. Just make
sure the parameter you set in "Function" can be called in from HTML page.

Example: Check "Call Javascript function" as action type, then input Function as
"testLightBox("Hello, this is a test"):
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® pown © Up ™ Move

® Over ® Dut

® Gotopage ™ Openalink © Call Javascript function

Function:

And then make sure the Javascript wrote into the index.html page as below image shows (the
same as you set in "Link Function"):

<head>
<title>PDF-BenU brochure 2010-100dpi</title>
<meta http-equiv="Content-Type™ content="text/html; charset=utf-8" />
<meta name="Keywords™ content="" /3>
<meta name="Description” content="" />
<meta name="Generator™ content="[Flip EDF version 3.0] at http://flipbuilder.com/™ />

<style type="text/csa™ media="screen™>
htel, bedy | height:;l00%:; }
body { margin:0; padding:0; overflow:auto:; text-align:center;
background-color; #££f£fif; )
#flashContent | display:inone; ]
Lfatyler

<script type="text/Javascript">

1runction teatLightﬂnglstrFrDmFlash]{
R =

do the things vou want hs

glert{acrFromFlash) ;
}

</script>

6. Add Movie

Click icon and then draw a box like below on the page you want to insert FLV movie:
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Then you can select and edit the movie in below panel (define video player skin color, play and
stop movie actions, etc.):

Movie Properties

Select FLY Movie

Player Skin Color:

Play Movie: When click Play button
: : When dick Play button
Stop Movie:

When enter the page

When leave the page

7. Add Image

Click icon E to draw image box and then select image (.jpg, .png, .bmp), set Action Options:

Image Properties Action Options

Action .Q'ptioné © Down @ Up @ Move
® Over ® Out

® Goto page © Openalnk @ Call Javascript function
® Open Flash Wndow @ Phy Audio ® Photo Skdeshow
URL:

Link Target: Blank

=
____________ .. ; m m

8. Add Sound

Click the icon - to draw sound box and then select sound file, set other options:
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Play Sound:

Stop Sound:

9. Add Flash

Click icon .

to insert SWF flash into your defined area of flipbook page:

10. Add Button

Click icon to draw an area for inserting your image or SWF button file with calling actions.
The actions contain "Go to page", "Open a link", "Call Javascript function" and "Open Flash
Window". The before three actions are the same with the actions in "Add Link", the "Open Flash
Window" can help you to play SWF Flash or FLV Video in the pop-up window:
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Button Properties Open Window Action Properties

Wi A . ¥ :,
Select an Icon(SWF,Image) Windaw Type: Open the window to play a video.
Action Options

Adi i
Window Content: Select The Elle

[ Acton options

Window Caption:

(= ] 5 - o, N J
R, AT Window Width: Window Height:

® Over ® Out

® Gotopage ® Openaink @ Call Javascript function

© Open Flash Window

B B3

11. Add You Tube Video

[ You |
Click the icon and then draw a box on the page to insert You Tube video into pages directly.

You just need to define the video ID directly. For example the video link is:
http://www.youtube.com/watch?v=xKA6W!IqjB7c, then the video ID is "xKA6WIqjB7c".

YouTube Video Properties

Video ID:

Video Parameters:

Play Movie: When click Play button

When dick Py button

Stop Movie:
When enter the page

NMhen leave the page

12. Add Printable Area
If you want readers can click on some area of your book to print the area directly, such as
coupons which can be used to buy your presented goods, you can add a "Printable Area" on

-
pages by clicking the icon , and then draw the area on the pages, set title and description:
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Link Properties

Color: B over Apha: B

Border Color: Border Width: B
Title:

Description:

13. Copy and Paste
If you want to add same links, images, videos, audios to different pages, you don't have to repeat
the "Link/Image/Video/Audio added" operations once and once again, just select the link object,

click the copy button and then go to the other page to click the paste button ﬂdirectly.

14. Apply All
If you want to use the same link, video, audio, image or button on all pages (or all odd, even
pages, or your customized pages), you can select the object and then click the Apply All button

N
, then define the apply page range in pop-up window like below:

Page Ranges

™ AllPages @™ Odd Pages ™ Even Pages

® Custom range:

1,3,9-1

After adding links, flash, movie or sounds, you can click the icon to save the settings and

back to the template setting interface.

Copyright 2012 by flash-flipping-book.com
-33-



Convert PDF to Digital Shopping Catalog Program
User for document

V. Language Options Interface

Click "Option->Flash Language", you will enter into the Language Settings interface as below
shows:

. Language Settings ﬁ

You can new or edit & language for the fash flipping book.
The Labled column below is the string that will be displayed in the fiash.
] The language will be st in the flash template setiings

Language tame:  (Chnese. v] [ dewiooguage| [ HKpeete | (B sovees.] [ Siied.

Language Settings

Label Labled Gl O [ 5 T
Frst Button B0 |
Hext Page Bution T—0 =
Last Button HE—m |
Brevicus Page Suttan Bi—m
Dewnload Button T
Print Button $TED
Seach Button %
Bk Mark Button B
Help Buttan i
Enable FulScreen Button 2R
Disable FullScreen Button 21

| Bim ok i B an=m =

Panel Description:

As the tips explaining, the "Labeled" column lists the buttons and instructions on Flash books
in defined language, and the program provides you five different languages for you to use:
English, Chinese Arabic, French and Greek.

Language Mame: im ish c!']

Arabic
Chinese
i III
French
Greek

You can also add other language for your own uses:

Y
1. Click the button [ New LE’”QU"’QEJ

and define name for the new language:

'H MNew Language ﬁw
Mew Language |
[aurrae: Frendh
Copy From: l_aw : v—_l
e ] [omm |

Click "OK" to save the new language in the list;
2. Choose the first label and click "Edit" icon, define new language text in "Labeled" box,
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Language Settings

Label

Kext Page Button

Last Button hast I Edti Language Item
Previus Pags Buttan Previgus pg ————————
Doweroad ::lm Dowriad || BEtLEmRage Strig |
Prink, Button Print

Saarch Button Seareh Label i FirstBution
Book Mark Button Boak Mark ~
Help Button Help |abeled:  Presdére|
Enable FulSoreen Button Enabla Fulls

Disabls Fullsersen Button Disainle Futd

| Bnemd Oim Busthne,

| soveandegtnest | |

[

Cancel

3. At last, you can get all Labels translated into your new language as the images shows:

Label

First Button

MNext Page Button

Last Button

Previous Page Button
Download Button

Print Button

Search Button

Book Mark Button

Help Button

Enable FullScreen Button
Disable Fullscreen Button

o imid P Bakbam

Labled

Premigre

Page suivante
Derniére

FPage précedente
Telécharger
Imprimer
Rechercher
Réservez Mark
Aide

Activer FullScreen

Désactiver FullScreen
| o Smamd

Delete
You can delete unwanted language:

Or save your edited new language file as XML or TXT file:

33 Load..,
Load language file saving before for current using:

After setting template and language, click

apply the settings.

f’ Apply Change
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VI. Output Interface

B Qutput Option ﬂ
Output |
Cutput type
f-? @ *html =zip 3 T exe : *.app
[7] also Make Mobile Version  Make output page-flipping eBook works on iPad, iPhone and Android mobile devices
Path
Output Falder: .C :.'n.l.jsers 'l,x!;ﬂm.in.is.tra.torinDesid.np '11.1'i|:;bn'c'uk i ’ Browse. .. | [ Cpen ]
File pMame: index 1.
Options
HTML Title: demo
|_—'| Burn to €O
ter [0:1:0,G; PLDS  DVD-ROM DH-16D55 VD15
' Make it automatically play the fiipbook in CO
[ Cancel l ’ Lonvert
Output types:
1. HTML

=

This output type is for uploading created page-flipping ebook onto websites:

You can define HTML Title and other properties by clicking "Advanced" button:

Options

HTML Title: demo .'_':; Advanced

Set Keywords, Description or even Script in the below interface:
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Advanced Settings ﬁ

HTML Adwvanced Settings |

HTML Meta Settings

Title: demo

Keywords:  pdf, flipboak, page-fipping, eback, online, webste, flash, background, music

Description:  This page-fipping #Book shows you the stunning flash effect on PDF pages, a

Add Scripts
You can put some tracking
code such a5 Google
Analytics here,
Need dosed <saipt>tag!
oK [ gancd_
2.ZIP

L e

This output type is for compressing the created files into an integral ZIP package which can
be sending out as attachment directly. You can also define HTML Advanced Settings by

clicking "Advanced" icon: &

Your recipients just need to uncompress the ZIP file and then they can view the HTML
flipbook instantly:

files

I|.;'!§u:Ier'r1r:u.htrnI

bunk.swf

This type is for outputting flipbook as a single executive file, easy storing and easy viewing:

=

| demo.exe

You can also define Icon and Opening Window Size in Advanced Settings:
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' Advanced Settings H"d‘

Exe Advanced Settings il
Exe Windar Info

Caption; dema
Teori: dﬂ v | | et |
Window Size Opltion

[Hlasmized Custom Size

& Eull Soreen

| gancet

If you want to make executable application to run on Mac devices, you can output as
"* app" format.

5. Mobile Version

i [¥] alsa Make Mabile Version |

You can even output Mobile Version while choosing HTML or ZIP format at the same time.
After creating mobile versions, you just need to output all files online (including HTML, SWF,
"files" and "mobile" folders), then you can visit the flipbook page through your mobile
browser.

6. Burn to CD

[¥]Burn to €D

CD Writer |D: 1:0;G: PLDS  DVD-ROM DH-16D55 VD15 »

Disc title: |Page-Flipping eBook

After choosing output type, then check the option "Burn to CD", set "CD Writer", define
"Disc title".

How to make created eBooks available for others online, more details this support page:
http://flash-flipping-book.com/support/how-can-i-share-my-created-ebook-online.htm .

At last click lbonuerty button to output flipbook in your defined type.
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VIl. Batch Convert Interface

Batch Convert |

| % Add PDF Documents

i acdries || Add Eolder creve 3 Cearl e L ave Py \
| Name Path
J-Fip Printer E:\Useful Documents'POFs Fip Printer. pdf
Fiip FDF E:\Useful Documents|FDFs Flip PDF. pdf
JaFip Viord E:\Useful Documents!PDFsFip Word.paf
J-eFip PPT E:\Useful Documents'PDFs Fip PP pf
| 23 settings

| Output Settings | PDF Sctfings |

Output type

@' @ =himl = *zp C@Q‘L = exe ‘, @ =app

[¥] Also Make Mobile Version  Make output page-flipping eBook works oniPad, iPhone and Android mabile devices
Path

Output Folder: C:\Users\Administrator\Desktop\fiipbook

File fame: {PDF FileName}

Flp Printer
Options
HTML Title: My FlipBook - [ Advanced
My FliipBock

[] Merge All POF Fies to One FipBook

| @&} Cconvert to Flash

Il }t Convert to Flash

1. Add PDF Documents
i Add Fies i

Click this icon to add PDF files from computer;

| s i Click this icon to add all PDF files in the folder (include sub-folders).

You can also remove some unwanted PDF, move up/ down files, or clear all documents.

x Remoue &f Clear All -@ Maove Up % Move Down

2. Settings

(1). Output Settings

i. Choose Output Type
Qutput type

i';%' @ *htm = @ *.zip r_’&j% @) *.exe i‘_ ©) *.app

[] Alsa Make Mobile Version  Make output page-flipping eBock works on iPad, iPhone and Android mobile devices

ii. Choose Output Path

Path

Qutput Folder: CiWsersVAdministratorDesktop I l Browse... H open ]

You can also define output name pattern with FileName, Title, Subject and so on:
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File Name; | HEbmE =a s 0= L.:J
{PDF Title}
{PDF Subject}

,j-iDF .ﬁ.uﬂﬁnri
POF FileMame]

And after defining the File Name, you can preview the result example below:

File Mame: {PDF FileName} Flipping Bock =

Flip POF Flipping Book

iii. Define Output Option

Options
Caption;  {FDF FileMame} -

Flip POF

Click "Advanced" icon to define Keywords, Description for HTML flipbooks, or define Icon,
Window Size for EXE flipbooks:
B tvanced Setiings _ﬂﬂ Advanced Settings ﬁ

HTML Acvanced Settrgs | |

Exe Advanced Settings
HTHL Meta Settngs Exe Window Info
T - Caption: dems
Epvwords:  pdf, fiobook, page-Apong, ebook, oniing,, websibe, fash, badground, musc
r ! 1
Desrpton: | Mhis page-fipping elsck shows you the shurning flach effect on POF pages, & s =
Add Sopt Window S Opbon
Tiou Can pul some frading Manamarad Cystom Size
%muﬁwﬁe
ytics have.
Need dosed <saiptatag! B Bl Sareen
Lo ] [Lomn | (o ] [Loma |

iv. Merge All PDF Files to One Flip Book

[#]iMerge All POF Files to One FlipBook:

(2). PDF Settings

i. Page Range

The Page Ranages to Import
71 All pages

.é'l E

Example: 1,9-21,30

You can convert "All pages" or just "Custom range";

Copyright 2012 by flash-flipping-book.com
-40 -



t

Convert PDF to Digital Shopping Catalog Program
User for document

ii. Watermark

Watermark
‘,n"" o~ Place a custom text or image
f;,,y Watermark{Stamp) to the file{s)

Click "Set Watermark" icon to enter into "Watermark" interface:

Option - w
[ watermark| ——= = =
1 .
V] Applying Watermark
Watermark Name Type ‘
¥ =
[T A rext-FivaL Text -
[Z] A Text - CoMPLETED Text [
[T A Text -oRAFT Text
M| [C] A Text-FOR PUBLIC RELEASE Text %
i [ A Text - INFORMATION ONLY Text =
2] A Text - MOT FOR PUBLIC RELEASE Text
] A Text - HOT APPROVED Text A 3¢ N
N ] A Text - Company(Tie) Text 3 |
[C1 A Text -LOGO feft-tog) Text &
] A Text -LOGO (Right-Top) Text
[F] A Text - LOGO (Left-Bottom) Text -,
] A Text -LOGO (Right-Bothom) Text
[Z] A Text - Dynamic - {tite) Tewt
| [7] = image -L0GO Image o i
! Lo ]| [ conen

Check "Applying Watermark" option, then you can choose default stamps, Edit them, or Add
Text Watermark, Add Image Watermark, Delete, Move Down/ Up.

iii. Page Quality

al i
Mediurm guality medium file size
Low guality small file size
Lower guality smaller file size

Choose quality and size type from listed five kinds.

iv. Other Options

Wi ook o your PDF file contains bookmarks, check this option to use in output

page-flipping eBook;

[Vi1mport links If your PDF file has links, check this to enable in flipbook;

[V|Enable search o oy this option to enable search functionality in created flipbook.

a0

1% Convert to Flash

At last, click icon to batch convert listed files together.
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VIIIl. Use Flip Shopping Catalog in Command Line

You can also use Flip Shopping Catalog in Command Line.

Flip Shopping Catalog Command Line Usage:
PTCMD.exe [Options]
-f<PDF File> The source PDF file.
-o<output folder> Specify the folder for the output files.
-t[html|zip | exe] Output type. Default is html.
-n<OutputFileName>  Specify the name for the output file.
-c<caption> Caption for HTML or EXE.
-s<Flash settings> Value format is:<Template name>#[<Theme name> |
<txt_settingfile path>].

<Template name> could be: Classic, Float, Spread.
<Theme name> are list in the "Select a template" window,

such as Blank,Blues,Nostalgia.
<txt_settingfile path> is the file that you export
with "Save the template settings" function

-r<page range>. The page range that you want to import from PDF File.
Range value string like:2-15,33,35-36,0r All.(Default: All)

-g<import quality> Count be 5,4,3,2,1.5 specify the higher quality larger file
size;1 specifies lower quality smaller file size.(default:4)

-R<GS|SWF|LIB> Render engine options. (Default: GS, Ghostscript render
engine)

-b<Y|N> Import bookmark yes or no. (Default: Y)
-I<Y|N> Import links yes or no. (Default: Y).
-S<Y|N> Enable searchable or not.(Default: Y, enable searchable)

-k<html key words> Set the keywords for html output file.
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-d<html description>  Set the descriptions for html output file.
-j<html javascript> Set the javascript for html output file.
-i<icon file path> Specify the icon path for exe output.

-w<window size> Specify the size of exe window.
Value could be: M,F, or some string like:800,600.
(width is 800,height is 600).

Examples 1:
PTCMD -f"C:\input.pdf" -0"C:\outputfolder" -n"index" -thtml -c"Title"
-s"Float#c:\my_ebooksetting.txt" -r"1-8,9-14,42" -q4 -R"SWF" -bN

Examples 2:
PTCMD -f"C:\input.pdf" -o0"C:\outputfolder" -n"ExeFileName" -texe -i"C:\app.ico"
-c"Title" -s"Float#Blues" -r"All" -g5 -R"GS"

Examples 3:
PTCMD  -f"C:\input.pdf" -0"C:\outputfolder" -n"index" -tzip  -c"Title"

-s"Float#Blank" -r"All" -5 -R"GS" -k"html key words"\

Return Code:

Success

Input file not found

Parameters are invalid

Failed to load PDF

Failed to import bookmarks

Failed to import links

Failed to import searchable information
Failed to save the output file.

N R WNRE
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License Agreements

All copyrights to Flip Shopping Catalog (the Software) are exclusively owned by
Flash-flipping-book.com. For more information, visit our website at
www.flash-flipping-book.com .

Anyone may use this software but all the page-flipping eBooks generated will automatically
have a demo watermark on the first page of them. To remove the limitation you must
register.

Once registered, the user is granted a non-exclusive license to use the Software on one
computer (i.e. a single CPU) at a time. The registered Software may not be rented or leased,
but may be permanently transferred, if the person receiving it agrees to terms of this
license.

The Software unregistered (trial) version may be freely distributed, provided the distribution
package is not modified. No person or company may charge a fee for the distribution of the
Software without written permission from the copyright holder.

THE SOFTWARE IS DISTRIBUTED "AS IS". NO WARRANTY OF ANY KIND IS EXPRESSED OR
IMPLIED. YOU USE AT YOUR OWN RISK. THE AUTHOR WILL NOT BE LIABLE FOR DATA LOSS,
DAMAGES, LOSS OF PROFITS OR ANY OTHER KIND OF LOSS WHILE USING OR MISUSING THIS
SOFTWARE.

You may not use, copy, emulate, clone, rent, lease, sell, modify, decompile, disassemble,
otherwise reverse engineer, or transfer the licensed Software, or any subset of the licensed
Software, except as provided for in this agreement. Any such unauthorized use shall result in
immediate and automatic termination of this license and may result in criminal and/or civil
prosecution.

All rights not expressly granted here are reserved by A-PDF Solution.

Installing and using the Software signifies acceptance of these terms and conditions of the
license.

If you do not agree with the terms of this license you must remove the Software files from
your storage devices and cease to use the product.
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How to Order

Order Online (http://www.flash-flipping-book.com/flip-shopping-catalog/index.html ) or
Order Toll Free 1-877-353-7297 (When you order toll free just give the operator the product
number of the product you would like).

How to purchase online?

1. Select a license type above, and click [Buy Now]

2. Select the currency that you want to use. (You can also continue shopping)

3. Fill billing information and select a payment method. (Your information is safe with us)
4. Check the information you filled previously and click "Place Secure Order"

Other Order Ways—With Phone/Mail/Fax/Check:

If you are not comfortable ordering online witha credit card, you are welcome to choose an
offline order option in the payment section of the order process. We accept mail, fax, wire,
and PO (if applicable) ordering options in addition to ordering online. We also provide
phone orders through our 24x7 order desk at 1-877-353-7297, or (952) 646-5331 for
International Callers.

Please note that all of the offline ordering options do have additional fees for processing. To
place an order by mail, fax, wire, and PO (when applicable), use the online form and then
choose one of these payment options found in the Payment Method section of the form.
Once submitted online, the appropriate information will be provided to you in your web

browser to send your payment to us offline.

100% unconditional 30 Day Money Back Guarantee

Want to custom the program or have other questions about purchase?
Contact us at support@flash-flipping-book.com .
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Support

You can easily search or browse our frequently asked questions, and learn tutorials about
products, and get your registration code back. If you are not satisfy with the solutions
provided, please contact support team for help.

1. Frequently Asked Questions

You can find answers to questions about technique issues here:
http://www.flash-flipping-book.com/support

2. Get lost license code

Click here to look up the order » (http://www.regnow.com/cs/orderStatus)

You can pull up a copy of your order by entering your email address. After you find your
order, you may view its status, view details of your order (including the license key), and
obtain the invoice.

3. Contact Us

If you have other questions or requirements, contact us directly through our support Email:
support@flash-flipping-book.com , we will respond you ASAP.
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